VF360 User Manual

03010-05093

Rev. 0D

'
.3
4
=
i
-
&
P
+

.




DISCLAIMER

The information in this document has been carefully checked and is believed to be entirely reliable. However, no
responsibility is assumed for inaccuracies. Parsec makes no representations or warranties with respect to the
contents hereof and specifically disclaims any implied warranties of merchantability or fithess for any particular
purpose. Furthermore, Parsec reserves the right to make changes to any product herein to improve reliability,
function or design, without obligation of Parsec to notify any person of such revision or changes. Parsec does not
assume any liability arising out of applications or use of any product or circuit described herein; neither does it
convey any license under its patent rights nor the rights of others.

Copyright Parsec (Pty) Ltd

All rights reserved.




Revision History

Revision Date Changes

0A December 2014 | First Draft release

0B January 2015 Added FPGA configuration and programming information

Added high power requirement

Added DSP PCle mode description, BIOS commands and vf360mon
description

Added DSP interface diagram and description

oC February 2015 | Added VPX pin connections
Cosmetics

0D December 2015 | Added FMC to FPGA information

Added FPGA speed grade options and 8-core DSP variant

Added DSP Boot options & updated BIOS settings table

Updated Power table (Table 2) and VPX P1 User Defined pins (Figure 5)




Table of Contents

About This Manual ..., 4
Chapters OVEIVIEW .......ccoiiiiiieiiiiie ettt ettt e e 4
DOCUMENE CONVENTIONS ....cuvvieiiriieiieee sttt eennee s 5
LYo T 1oz VIS U1 o] o 1o i PR 5
1 INtrOdUCTION ..o, 6
1.1 The VF360 OpenVPX FPGA & DSP Processing Module................ 7
1.2 FEATUINES ... 8
1.3 Product APPlICAtIONS .......cvveveiiieieiiieeeeeeeeeeeeeeeeee e eeeeeeeeeeeeaeeeeeanaees 10
1.4 Reference DOCUMENTS ........cveveiiiiieeiiiieee e 10
2 Product OVErview .........ccoooevveiiiinieeieiiieeeee, 11
2.1 Overview of the VF360...........ccccocviiiiiiiiiii i, 12
2.2 Board Management..........coiuuiiiiiiiieeeiiiiee e 13
2.3 VPX INEEITACE ... 13
2.4 DSP INtEITACES .....oveiiiiriiee et 16
25 FPGA INTEIACES.....ciiiiiiiie it 18
2.6 VF360 ReSet StrUCLUIe........ccooiiiiiiiiiiciiiiee s 21
2.7 VF360 ClOCK SIIUCTUIE ...t 21
2.8 Debug INtErfaCES ......coiviiii i 24
3 Specifications ........cociiiiiiiiiiii 25
3.1 General SPecifiCatioNs ........ ... 26
3.2 Environmental Specification................evvviiieiiiiiiiiiiiiiiieeeieeeeeeieeeenens 26
3.3 Power Supply ReqQUIrEMENtS .........ccevvviiiiiiiiiiiieeieieeieeeeeeeeeeeeevenenenns 26
3.4 Ordering INfOrMation ...........ooouiiieiiiiiie e 27
4 Installation and Setup.........ccccceeeveiviieiinennn, 28
4.1 Unpacking the product ... 29
4.2 Installing the VF360 Hardware............ccccceeiiiiiiiiiiiiieeiiieeee e 29
4.3 Installing the VF360 Software and Firmware ............cccocccvveeeeeennn. 30
4.4 Installing Code COMPOSEN......ccceiiiiiiiiiiiieae et 31
4.5 Installing QUAITUS Il .......eoiiiiiiiiiii e 31
4.6 Installing a terminal program..........cccooceeeeiiieee e 31
5 Operating Guide.......c.coovveviiiiiiiiiiiiieeeceei, 32




Configuration SettiNgS........cccvviiiiiee e 33

StAtUS INAICALONS ....vvveiiiiieeeee e 33
V360 SOMWANE ...eeeiiiiiieiiiiee et 34
VF360 FirMWare........cccoiiiiiiiiiiii i 38
Monitor, BIOS & GPIOS ........ccoovvviiiiiiiieee. 41
MONItOr COMMEANGS.......eiiiiieiieie e 42
][ @ ST T=1 1] o TSR 42
GPIOS. . 45




Table of Tables

Table 1:
Table 2:
Table 3:
Table 4:
Table 5:
Table 6:
Table 7:
Table 8:
Table 9:
Table 10
Table 11

V360 FPGA FMC SIQNQIS ...vviieiiiiie ettt ettt e stae e e e stae e e e sntae e e s nntaeaeennneas 18
VE360 Power SUPPIY FEQUIFEMENTS .......oeiiiiiiieeiiiiie ettt 26
INStall CD dIir€CIONY SIFUCTUIE ....ceeiiiiieeeitiee ettt e et e e e b e e e e sbneeeeanes 31
Front panel LED INAICALOIS .......ccciiiiiiiiiiiiee ittt et e e s snneeeeaaes 33
NAND flash PartitionNs ........occuiiiiiiee e e e e e e s s rrrereeee s 37
GDiscretel BOOt SEIECHON .......uuiiii ittt sttt s e e e s naeeee s 37
Overview of FPGA PCle BAR reqUIr€MENT........ccoocuiiiiiieee e ciciiiieece e seieee e e e e neeeeees 38
VEF360MON COMMEANTS ...ttt e e et e e e e e e st e e e e e e e e e annbnrneeeaaaaeas 42
BIOS COMMENTS.....eeitiieeiiiiitie ittt e e e e e e e et e e e e e s e s bbb b e e e e e e e e e annnbreeeeaeeeas 43
I BIOS REQISIEN SEINGS ..uuuiniiiiii s 43
B 5] €1 o [ 1 P 45

Table of Figures

Figure 1:
Figure 2:
Figure 3:
Figure 4:
Figure 5:
Figure 6:
Figure 7:
Figure 8:

V360 BIOCK DIAQIaIM ... s 7
VF360 System architecture diagram........ccoooooeoieiiiiiiiccccec e 12
VE360 SIOt Profile ..o 13
VPX PO Slot Profile assignmENtS .......ccooiiiiiiiii s 14
VPX P1 & J1 Slot Profile aSSigNmMENTS.........coouuiiiiiiiiiiiiiee et 15
VPX P2 & J2 Slot Profile aSSigNmMENTS.........cocuuiiiiiiiiiieiieie e 16
RV TG O 1S T o] (=Y o = Lo PO 17
VF360 FMC FPGA SIGNAIS ...ttt st 18

Figure 9: FPGA DDR3 Memory DANKS ........cooiiiiiiiii e 19
Figure 10: FPGA QDR MEMOIY DANKS ........oiiiiiiiii ittt 19
Figure 11: FPGA HSSI CONNECLIONS .....ccoeeee e, 20
Figure 12: VF360 CIOCK StIUCLUIE.......ccceee e, 21
Figure 13: VF360 clocks and IO banks ... 23
Figure 14: FM500 FPGA Mezzanine Card ... 24
Figure 15: VR300 Rear Transition Module ... 24
Figure 16: ifconfig terminal WindOow ... 34
Figure 17: Ispci terminal WINAOW ... 35
Figure 18: VF360MON NEIP SCIEEN ......iiiiiiiiie ittt s e e e 35
Figure 19: Code Composer target CONfIgUIatioN ............ccueiiiiuiiieiiiiiee e 36
Figure 20: Code Composer DSP Core0 CONNECIEM ........c.uueieiiiiiieiiiiiie e 36
Figure 21: VF360 Firmware Reference Design top level diagram ..........cccccevviiieiiiii e, 38
Figure 22: ALTERA USB-BIaSter SEIUD .. ...uuetiiiaiiiiiiiiieie ettt e e et e e e e e s snereaeeeas 39
Figure 23: FPGA configuration Via JTAG .....ccooiiiiiiiiiiieie ettt e e e aee s 39
Figure 24: FPGA programming VI& JTAG .....cooiiiiiiiiiiiieia ettt e e e nnnneee s 40




About This Manual

This manual consists of information to simplify your
installation, configuration and operation of the VF360 board.
About this Manual describes the contents of each chapter and
includes document conventions and technical support
information

Chapters Overview

About This Manual - This chapter provides an overview of the chapters, document conventions, and technical
support information.

Chapter 1 Introduction - This chapter provides a brief introduction to the VF360 3U FPGA and DSP OpenVPX

Processing Module. It also provides a list of reference documents whose information supplements this user
manual.

Chapter 2 Product Overview - This chapter provides detailed functional information for the VF360.
Chapter 3 Specifications - This chapter provides the specifications for the functional areas of the VF360.
Chapter 4 Installation and Setup - This chapter includes instructions for unpacking and installing the VF360.
Chapter 5 Operating Guide - This chapter provides information on proper operation of the VF360.

Chapter 6 Monitor, BIOS & GPIOs - This chapter describes the VF360 BIOS settings and the DSP GPIO
usage.

Acronym List - This chapter expands abbreviations used in this manual.




Document Conventions

The following icons are used in this manual to emphasize setup or system information:

Icon Use
)» Alerts you to the important details regarding the setup and maintenance of
“@ your system.

Alerts you to potential damage to the board during system setup and
installation.

Technical Support

Should you require additional technical information or assistance, contact Parsec (Pty) Ltd:

Telephone: +27 12 6789 740

Facsimile: +27 12 6789 741

E-Mail: support@parsec.co.za

Web Site: http://www.parsec.co.za



mailto:support@parsec.co.za
http://www.parsec.co.za/

VF360 USER MANUAL

1 Introduction

This chapter provides a brief introduction to the VF360 3U
FPGA and DSP OpenVPX Processing Module. It also provides
a list of reference documents whose information supplements
this user manual.
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1.1 The VF360 OpenVPX FPGA & DSP Processing Module

The VF360 is a 3U OpenVPX module that leverages on ALTERA Stratix® V FPGA and Texas Instruments
KeyStone Multicore DSP technology to provide an ultra-high bandwidth processing platform, ideally suited
for computation and bandwidth intensive applications such as Radar, Networking, SIGINT, EW, SDR and
Video.

The VF360 uses an ALTERA Stratix® V GX/GS FPGA device to implement a high-speed processing node. The
FPGA is available to the user for custom firmware development. Depending on the FPGA resources required,
one of ten different FPGAs from the Stratix® V GX and GS families can be mounted on the VF360.

The Stratix® V FPGA has two banks of dedicated DDR3 and QDRI+ memories for algorithms with high
bandwidth and/or large memory size requirements. High-speed serial interfaces to the OpenVPX data plane and
the FMC site creates abundant FPGA 10 throughput.

The on-board KeyStone Multicore C667X DSP processor from Texas Instruments provides the flexibility to
perform complex post processing functions more suitable for the processor domain. High bandwidth
communication between the DSP and FPGA is provided through both PCle and Serial Rapid 10 (SRIO)
interfaces.

The VF360 acts as an FMC carrier to provide a modular solution that accommodates a wide range of 1/O
reguirements.

The VF360 conforms to the OpenVPX standard and operates as a Payload module with System Controller
capability. Both air-cooled and conduction cooled versions are available.

2X Eth
2X

$

4X SRIO

10X HSSI

LVDS

10X HSSI
24 10s

Figure 1: VF360 Block Diagram
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1.2 Features

7
*

7
*

High speed FPGA processing with ALTERA Stratix® V GX/GS FPGA

GX Device variants: 5SGXA3, 5SGXA4, 5SGXA5, 5SGXA7, 5SGXA9 and 5SGXAB
GS Device variants: 5SGSD4, 5SGSD5, 5SGSD6 and 5SGSD8

Embedded device memory: 19-52 MBits

Embedded device multipliers (18x18) : 512 — 3,926

FPGA external DDR and QDR memory
Up to 2GB DDR3 @ 667MHz (arranged as two 256M x 32-bit banks), default 1GB

Up to 32MB QDRI+ SRAM @ 400MHz (arranged as two 8M x 18-bit banks), default 16MB

High speed DSP processing with Ti KeyStone Multicore C667X DSP processor
DSP variants: One, two, four (standard) or eight cores @ 1GHz

DSP dual-boot option for Linux or 2" boot OS (e.g. SYS/BIOS or other RTOS)

DSP external DDR memory

Upto 2 GB DDR3 @ 667MHz (matched to FPGA DDR3 size), default 1GB

DSP and FPGA is connected through PCle (x2) and Serial Rapid 10 (SRIO x4) interfaces
VITA 57 FPGA MEZZANINE CARD (FMC) site
10x High-Speed Serial Interface (HSSI) lanes

58x Differential LVDS interfaces on LA and HA

VPX INTERFACE
Comply with OpenVPX MOD3-PAY-3F2U-16.2.12-2 module profile
» PCle Gen2 Data plane (3x Fat Pipes)
» GigE 1000BASE-BX Control plane (2x Ultra-Thin Pipes)
» Payload module with System Controller capability
Supports FPGA configurable User I/O on P2
» 10x High-Speed Serial Interface lanes

» 24xsingle-ended 2.5V LVCMOS I/0Os
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R/

% FPGA configuration
Automatic configuration of FPGA after power-up from on-board non-volatile storage

DSP can configure FPGA from an RBF file

« SOFTWARE & FIRMWARE SUPPORT
Linux distribution and BSP (Board support package)
» PCle driver for FPGA with DMA support
» EP (endpoint) ‘driver’ for DSP in ‘slave’ (Payload module) mode

» Test application showing FPGA memory access and PCle DMA

» Software Reference Manual
FPGA Firmware Reference Design
» PCle interface with Read/\Write and DMA
» DDR3 and QDRII+ memories connected to QSYS fabric
» High-Speed Serial Interface (HSSI) block connected to SERDES links
» Quartus Project files
» Firmware Reference Manual
« Custom FPGA firmware /application /driver development available upon request
< FMC COMPANION MODULES

FM500 Test FMC with USB-Blaster II, XDS100 and mini-SAS interface

FM510 Video 10 FMC with HD (3G-SDI) video, SD (Analogue) video, RS422, RS485, CAN, Digital I0s &
stereo Audio interfaces

FM550 FMC with Dual mini-SAS interface

VR300 Test RTM with USB-Blaster I, XDS100 and Ethernet (via SFP)
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1.3 Product Applications
The VF360 is targeted at applications requiring the following:

» Ultra-high bandwidth (= 10Gbps) full-duplex serial I/O requirements
» High bandwidth (= 500MB/s) PCle data throughput

» High concentration DSP processing resources

» High-speed FPGA processing

» Real-time DSP processing

A few typical applications well suited for the VF360 platform are:
» Real-time DSP functions (DDC, FFT, FIR, etc.)
» Video and Image Processing functions (Symbology, DCT, 1D/2D Convolution, etc.)
» Radar Signal Processing (Doppler filter, Pulse compression, CFAR, etc.)
» Spectrum analysis in EW (Signal detection & classification, jammer control)

» Software Defined Radio (SDR)

1.4 Reference Documents

The following sources provide important reference information that may provide useful in achieving optimal
operation of the VF360:

[1] VF360 Software Reference Manual
[2] VF360 Firmware Reference Manual
[3] FM500 FMC Product Brief
[4] VR300 RTM Product Brief

[5] ALTERA STRATIX® V Device Handbook

10
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2 Product Overview

This chapter provides detailed functional information for the
VF360.

11
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2.1 Overview of the VF360
The VF360 is a 3U OpenVPX module that leverages on ALTERA Stratix® V FPGA and Texas Instruments
KeyStone Multicore DSP technology to provide an ultra-high bandwidth processing platform, ideally suited for
computation and bandwidth intensive applications such as Radar, Networking, SIGINT, EW, SDR and Video.
Figure 2 shows an architecture diagram of the VF360 in its standard configuration.

% The Board Management function powers up the VF360 and boots the DSP Core0

% The FPGA boots from on-board non-volatile memory (an EPCQ device)

«+ Core0 boots the Linux kernel and performs PCle enumeration when the VF360 is a System Controller.
Cores 1-3 are available to run code in the Tl SYS/BIOS environment

+ The FPGA Reference Firmware connects the DDR and QDR memories to the DSP via the PCle and
SRIO interfaces. The PCle and SRIO share the same FPGA memory map

Power
_P.r_“essor ««——»{ Board Management [€——
DDR3 b Core0 boeoy [€— T Configuration EO
1GB P 2==={ Core1} VPX-PO
! Core2 52254
_)"---—t\COre3 \l‘ M
+ 2X
E4 < 4X SRio 1 PCle
Debug |~ _jxEth—P————— MN——2X Eth
I y
» } N FPGA e
é ) 8X pcle [€HX» VPPl
€—2X HSSI—> €l switen €
E3 [ €—AX—)p!
Fvc  [€8XHSS— Reference
Firmware
[ —58X LVDS—P]
k ) [ ——10X HSS|———P»
€ 24X 10—
& & & e2
ommomee DDR1 DDR2 QDR1 QDR2 VPX-P2
J Board % 4 ) 4 4 v
* Support DDR | DDR | QDR | QDR
«_Package ¢ 512MB | 512MB | 8mB | 8wmB
Sooocae?’

Figure 2: VF360 System architecture diagram
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2.2 Board Management
The VF360 Management Controller (MANCON), an Atmel ATXMega device, performs the following functions:

% Monitors external power supplies (VS1=12V, VS2=3.3V and VS3=5V) for correct levels

« Enables local power supplies

% Performs reset actions (nNSYSRESET and local resets)

% Continuously monitors external voltages and local voltages and temperatures

o Communicates voltages and temperatures and other information to the DSP Linux host

o Shuts-down VF360 if any power supply or device temperature is out of its operating limits.
o Logs internal shut-down event in non-volatile memory

The voltages and temperatures communicated to the DSP Linux host running on Core0, are served over Ethernet
by the VF360 Monitor application (vf360mon) service running on Linux.

Refer to § 6.1 for detail on the vf360mon commands.
VF360mon also provides access to the VF360 BIOS options, for more detail refer to § 6.2.

2.3 VPX Interface
The VF360 complies with the 3U OpenVPX slot profile SLT3-PAY-3F2U-14.2.13 as shown in Figure 3.

== Key

Utility Plane j

~ Data Plane — 3 Fat Pipes

User Defined <

= User Defined

AAN

Utility Plane Control Plane — 2 Ultra-Thin Pipes
g| Diff
User Defined P2{— > User Defined
E J2

- Key

Figure 14.2.13-1 Payload Slot Profile SLT3-PAY-3F2U-14.2.13

Figure 3: VF360 Slot Profile

13
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The VF360 standard module profile (MOD3-PAY-3F2U-16.2.12-2) provides the following VPX interfaces:

PO as per ANSI/VITAG65 OpenVPX

3x PCle Gen2 Data plane Fat Pipes (4X) on DP01 to DP03

MOD3-PAY-3F2U-16.2.12-1 is also supported with PCle Gen1 on the Data plane

Two GigE 1000BASE-BX Control plane Ultra-Thin Pipes on CPutp01 to CPutp02

P2 User Defined connections according to ANSI/VITA46.9 Pin Field X24s+X8d+X12d

20 Differential pair I0s

24 Single-ended I0s

As shown in Figure 13, the P2 User Defined signals connect to FPGA transceiver bank R(0-2) and 10 bank 4D.

The following three figures show the VF360 connector and Backplane connector pin assignments.

Row G Row F Row E Row D Row C Row B Row A
1 | vs112v) Vs1 (12V) Vsi (12V) No Pad Vs2 (3.3V) Vs2 (3.3V) Vs2 (3.3V)
2 | Vs1(12v) Vs1 (12V) Vs1 (12V) No Pad Vs2 (3.3V) Vs2 (3.3V) Vs2 (3.3V)
3 [ vs3v) Vs3 (5V) Vs3 (5V) No Pad Vs3 (5V) Vs3 (5V) Vs3 (5V)

Reserved x

4 || sM2 SM3 GND (-12V_Aux) GND SYSRESET NVMRO
5 | GAP" GA4” GND 3.3V_Aux GND SMO SM1

e x Reserved - o
g | GA3 GA2 GND (+12V_Aux) GND GA1 GAO
7 | TCK GND TDO TDI GND TMS TRST*
8 GND REF_CLK- REF_CLK+ GND AUX_CLK- AUX_CLK+ GND

Figure 4: VPX PO Slot Profile assignments

14
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Plug-in Row G Row F Row E Row D Row C Row B Row A
module P1 Even Odd Even Odd
Bplane J1 Row i Row h Row g Row f Row e Row d Row c Row b Row a
1 = S| GDiscretel GND GND-J1 DP01-TDO- DPO01-TDO+ GND GND-J1 DP01-RDO- DP01-RDO+
2 § 2 GND DP01-TD1- DP01-TD1+ GND-J1 GND DP01-RD1- DP01-RD1+ GND-J1 GND
3 % § P1-VBAT GND GND-J1 DP01-TD2- | DPO1-TD2+ GND GND-J1 DP01-RD2- | DPO1-RD2+
4 g © a GND DP01-TD3- DP01-TD3+ GND-J1 GND DP01-RD3- DP01-RD3+ GND-J1 GND
5 = < | Sys_con GND GND-J1 DP02-TDO- | DPO2-TDO+ GND GND-J1 DP02-RDO- | DP02-RDO+
6 E E GND DP02-TD1- | DP0O2-TD1+ GND-J1 GND DP02-RD1- | DP02-RD1+ GND-J1 GND
7 % § Reserved GND GND-J1 DP02-TD2- | DP02-TD2+ GND GND-J1 DP02-RD2- | DP02-RD2+
8 g 3 GND DP02-TD3- DP02-TD3+ GND-J1 GND DP02-RD3- DP02-RD3+ GND-J1 GND
9 2 S| UDEB-TX GND GND-J1 DP03-TDO- DPO03-TDO+ GND GND-J1 DP03-RDO- DP03-RDO+
10 E 5 GND DP03-TD1- | DP03-TD1+ GND-J1 GND DP03-RD1- | DP03-RD1+ GND-J1 GND
11 % § UDEB-RX GND GND-J1 DP03-TD2- DPO03-TD2+ GND GND-J1 DP03-RD2- DP03-RD2+
12 g 4 GND DPO03-TD3- DP03-TD3+ GND-J1 GND DP03-RD3- DP03-RD3+ GND-J1 GND
13 5 . UDSPR-SE GND GND-J1 UDMDCLK UDMDIO GND GND-J1 UDUSB- UDUSB+
14 8 c GND UDID-SK UDID-CS GND-J1 GND UDID-DO UDID-DI GND-J1 GND
15 Se g:::ﬁble GND GND-J1 ?g_‘“poz' $Dprtp02- GND GND-J1 ggl_npoz- g;ﬂtpoz'
c ®©
16 8e GND %;’_utpOl— _(?[F;EtpOl- GND-J1 GND ggtftpOl— ggtitpm- GND-J1 GND

Figure 5: VPX P1 & J1 Slot Profile assignments

UDEB-TX/RX is the DSP debug serial port.
UDUSB+/- is the USB interface for the FPGA USB-Blaster Il via the VR300 RTM.
UDMDCLK/MDIO connects to the MDIO bus of the DSP
UDID(CK, CS, DI & DO) are 2.5V FPGA IOs that connect to the EEPROM on the VR300 RTM for ID information

UDSPR-SE is a single-ended spare line that connect to a 2.5V FPGA Bank (4D)

15
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T ey
Plug-In Row G Row F Row E Row D Row C Row B Row A
Module Even Odd Even Odd
P2
Bplane
J2 Row h Row g Row f Row e Row d Row ¢ Row b Row a
1 GND GND-J2 X24s23 X24s21 GND GND-J2 X24s24 X24s22
2 X24s19 X24s17 GND-J2 GND X24s520 X24s18 GND-J2 GND
3 9 GND GND-J2 X24s15 X24s13 GND GND-J2 X24s16 X24s14
4 X X24s11 X24s09 GND-J2 GND X24s12 X24s10 GND-J2 GND
5 GND GND-J2 X24s07 X24s05 GND GND-J2 X24s08 X24s06
6 X24s03 X24s01 GND-J2 GND X24s04 X24s02 GND-J2 GND
7 GND oNpy2 | xgdorTp- | X390% GND GNDJ2 | X8d0O1-RD- | X8d01-RD+
X8d02-
8 - X8d02-TD- | To. GND-J2 GND X8d02-RD- | X8d02-RD+ GND-J2 GND
o
9 X GND GND-J2 X8d03-TD- ;(31103— GND GND-J2 X8d03-RD- X8d03-RD+
X8d04-
10 X8d04-TD- | T, GND-J2 GND X8d04-RD- | X8d04-RD+ GND-J2 GND
X12d01- X12d01- X12d01-
11 GND GND-J2 - o+ GND GND-J2 X12d01-RD- | oo
X12d02- X12d02- X12d02- X12d02-
12 TD- o+ GND-J2 GND RD- RD+ GND-J2 GND
X12d03- X12d03- X12d03-
13 3 GND GND-J2 - TD+ GND GND-J2 X12d03-RD- RD+
—
< X12d04- X12d04- X12d04- X12d04-
14 TD- o+ GND-J2 GND RD- RD+ GND-J2 GND
X12d05- X12d05- X12d05-
15 GND GND-J2 - D+ GND GND-J2 X12d05-RD- RD+
X12d06- X12d06- X12d06- X12d06-
16 GND - D+ GND-J2 GND RD- RD+ GND-J2 GND

Figure 6: VPX P2 & J2 Slot Profile assignments

UDTxx and UDEMU[1:0] is the DSP emulator lines on the XDS100
UDJSEL* is an active low select line, indicating that the XDS100 USB cable is plugged into the VR300 RTM.

2.4 DSP interfaces

The DSP interfaces to the FPGA and other related devices are shown in Figure 7.

DSP local resets, NMI, GPIO[13:0], SRIO[3:0], TimI[1:0], TimOJ[1:0] and SPI interface on CS1 connects to the
FPGA. GPIO[Q] is used to reset the FPGA.

The FPGA can be configured by the DSP, after initial power-up configuration, through the DSP’s SPI interface.
For detail refer to 5.3.5.

The PCle interface connects to the PCle Switch and the two SGMII interfaces (Ethernet) connect to the VPX
Control Plane.

The DSP reset and booting is controlled by MANCON via the Control CPLD.

16
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| € PCle_nRESET
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VPX

CPutp[2:1]

EEPROM Clk25M RTC
v MFP
EEPROM_WP—— ; < I >
<€——Clk12M5 :
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y
FPGA_nRESET DPOL_RD[3:0]
e C50, [SPICIK, SpIDin, SPIDOU | - - - - : € 5ot To[3:0] >
: PCle ¢ DP02_RD[3:0],__ N
: SWITCH DP02_TD[3:0]
nCs, DATA[3:0 EPCQ f .
D [3:0] <—| : DPO3_RD[3:0],
: < DP03_TD[3:0] >
DCLK "’4"
= PGA P$ Configuratior I
< FPGA_PCle_R[7:0],

Figure 7: VF360 DSP interfaces
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2.5 FPGA Interfaces

The FPGA interfaces are shown in Figure 2 and Figure 7 and are described in more detail in the following
sections. For detail on the FPGA interface pin mappings, refer to [2].

2.5.1 DSP Interface

Refer to 2.4.

2.5.2 FMC Interface

The VF360 support the ANSI/VITA 57.1 FPGA Mezzanine Card (FMC) high-pin count (HPC) connector with the
following connections to the FPGA, as shown in Figure 8. The FMC_HBJ[0:21]p,n signals are not provided for.

Tx

<—FMC_LA[00..33]p,n—|—_> Rx

Tx

<—FMC_HA[00..23]p,n—|—_> Rx
€——HB[14]p,n—————P|
€———HB[16]p,n———————— P

FMC FPGA

HPC —————————CLK[0..1]_M2Cp,n———p]
Connector [€—CLK[2]_BIDIRp,n———p

ClkOut
<—CLK[3]_B|D|Rp,n—|—_> Clkln
—————CLK_DIR—————— )

GBTCLK[0..1]_M2Cp,n—>

FMC_DP[0..9]_M2Cp,n—
€——FMC_DP[0..9]_C2Mp,n

Figure 8: VF360 FMC FPGA signals

The maximum input voltage on FPGA signals from the FMC is 2.5V.
The VF360 does not support 3.3V on its FMC interface signals.

Descriptions of the FPGA FMC signals are shown in Table 1.

Table 1: VF360 FPGA FMC signals

Signal FHEA o Description
9 Pins Standard P
LA[00..33]p 2.5Vor . . . . § )
LA[00..33]n 2x 68 LVDS Differential pairs or single-ended signals to/from FPGA
HA[00..23]p 2.5V or . . . . .
HA[00..23]n 2x 48 LVDS Differential pairs or single-ended signals to/from FPGA
HB14p, HB14n, . .
HB16p, HB16N 4 2.5V Single-ended signals to/from FPGA
CLK[0..1]_M2Cp,n 4 LVDS Two Differential Clocks from FMC to FPGA
CLK[2..3]_BIDIRp,n | 4 LVDS Two Bidirectional differential clocks between FMC and FPGA
CLK_DIR 1 2.5V Direction signal for CLK[2..3]_BIDIR

CML / . . .
GBTCLK][0..1]_M2C | 4 LVDS FPGA Reference clock inputs for FMC transceiver signals DP[0..9]
DP[0..9]_M2C 20 CML 10x HSSI transceiver inputs on FPGA
DP[0..9]_C2M 20 CML 10x HSSI transceiver outputs on FPGA
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For detail on specific clock connections between the FMC and FPGA, refer to Figure 13. For detail on the HSSI
connections between the FMC and FPGA, refer to Figure 11.

Note that the FMC_LA[] and FMC_HA[] signals connect to LVDS transmitter (Tx) and LVDS receiver (Rx)
pins on the FPGA, since the FPGA LVDS pins are uni-directional.

2.5.3 DDR memories

The VF360 FPGA is connected to 1GByte of DDR3 memory, arranged as two banks of 128M x 32-bit memory
running at 400MHz (standard build). The two DDR banks are completely independent with separate clock, control
address and data lines as is shown in Figure 9.

-FPGA_DDR1_CLK——
~FPGA_DDR1_CTRL[[—»  DDR3
~FPGA_DDR1_A[l—» Bank-1
FPGA_DDR1_D[]—

FPGA

“FPGA_DDR2_CLK——
~FPGA_DDR2_CTRL[]—»  DDR3
FPGA_DDR2_ All—>»  Bank-2
<FPGA_DDR2_D[]—

Figure 9: FPGA DDR3 memory banks

The VF360 Reference firmware connects the DDR3 memories to the ALTERA QSYS fabric, through which it can
be access by the DSP via PCle (core 0) or SRIO (cores 1-3).

2.5.4 QDR memories

The VF360 FPGA is connected to 16 MByte QDRII+ memory, arranged as two banks of 4M x 18-bit memory
running at 400MHz (standard build). The two QDR banks are completely independent with separate clock, control
address and data lines as is shown in Figure 10.

+QDR1 CLK——p
~QDR1_CTRL[]———p QDRI+
~QDR1_SA[]———>
~QDR1 D[———»  Bank-1
«QDR1_QJ] ‘

~QDR2 CLK———p
~QD2_CTRL[]———» QDRI+
~QDR2_SA[]—————>
~QDR2 D[———» Bank-2
<QDR2_Q[] ‘

FPGA

Figure 10: FPGA QDR memory banks

The VF360 Reference firmware connects the QDR memories to the ALTERA QSYS fabric, through which it can
be access by the DSP via PCle (core 0) or SRIO (cores 1-3).
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2.5.5 FPGA High-Speed Serial Interfaces

The FPGA transceiver and reference clock connections are show in Figure 11. The left and right banks are

swapped on the diagram, as it depicts the top view of the FPGA device.

The 18 right side transceivers connect to the User defined P2 VPX connector through X8d[4:1] and X12d[6:1] and
to the FMC connector through FMC_DP[7:0]. Two of the reference clocks are provide by the FMC through

VF360 USER MANUAL

GBTCLK]1:0]_M2C and one by the on-board Clock Generator through CLK_FPGA Ref3 @ 125MHz.

Fourteen left side transceivers connect to the PCle Switch through FPGA_PCle[7:0], to the DSP through
SRIO[3:0] and to the FMC connector through FMC_DPJ[9:8].. CLK_FPGA_PCle runs at 100MHz and
Clk_FPGA_SRIO at 156.25MHz.

Clock
generator

XCVRs Right Bank 0

XCVRs Left Bank 0

—CIk_FPGA_Ref3—3

VPX-P2

X8d1:

X8d2

X8d3
X8d4-

X12d1

X12d2

RefCIkRO
RefCIkR1

GXBRO
GXBR1
GXBR2
GXBR3
GXBR4
GXBR5

RefClkLO
RefClkL1

GXBLO
GXBL1
GXBL2
GXBL3
GXBL4
GXBL5

XCVRs Right Bank 1

XCVRs Left Bank 1

—GBTClk1_M2C-)

N—X12d3
N—X12d4

FMC

NFMC_DP7—
N-FMC_DP6—
N-FMC_DP5—)
N—FMC_DP4—

TTTTTT

RefCIkR2
RefCIkR3

GXBR6
GXBR7
GXBR8
GXBR9
GXBR10
GXBR11

RefClkL2
RefClkL3

GXBL6
GXBL7
GXBL8
GXBL9
GXBL10
GXBL11

XCVRs Right Bank 2

XCVRs Left Bank 2

——GBTCIkO_M2C—)

VPX-P2

X12d5

X12d6

FMC

FMC_DP3
K——FMC_DP2——
K——FMC_DP1—

K——FMC_DPO—

RefClkR4
RefCIkR5

GXBR12
GXBR13
GXBR14
GXBR15
GXBR16
GXBR17

RefClkL4
RefClkL5

GXBL12
GXBL13
GXBL14
GXBL15
GXBL16
GXBL17

. Clock
K—Clk_FPGA_PCie—] "0
K—FPGA_PCle_0—)
K—FPGA_PCle_1—)
K—FPGA_PCle_2—)

K FPGA_PCle_3—)
K FPGA_PCle_4—)
PCle
Switch
K FPGA_PCle_5—)
K FPGA_PCle_6—)
K FPGA_PCle_7—)
K—FMC_DPe—)
FMC_DP9 ENIE
Clock
K—Clk_FPGA_SRIO—] -0
SRIO_O
SRIO_1
SRIO_2 Dsp
SRIO_3

Figure 11: FPGA HSSI connections
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2.6 VF360 Reset Structure

As described in § 2.2, NSYSRESET and local resets are performed by MANCON. MANCON generates the DSP
and PCle resets. The FPGA is reset by the DSP via GPIOO0. A hard/warm or soft/cold reset can also be generated
through vf360mon.

2.7 VF360 Clock Structure

The VF360 clock structure is show in Figure 12. The clock generator block generates the DSP Core, DDR, PCle
and SMII/SRIO clocks as well as the following FPGA clocks:

» CLK _FPGA PCle[l1:2]

» CLK_FPGA SRIO

» CLK_FPGA Ref (VPX REF_CLK)

» CLK_FPGA Core (DDR & QDR memories)

> CKL_FPGA 125M

> CLK_FPGA_Ref3
Clock frequencies are listed in 8 3 (Specifications). VPX REF_CLK (LVDS) is driven to or received from the
backplane, depending on whether the VF360 is the system controller or not. Being a system controller, VPX

REF_CLK can also be disabled through a BIOS option and then received from the backplane, refer to 6.1 for
detail.

A CPLD divides a 25MHz clock input by two and routes a 12.5MHz clock to the FPGA.

1 CLK_DSP_Core—————t
2 CLK_DSP_DDR—»  pgp
3 f——————CLK_DSP_PCle—————1
6 f————CLK_DSP_SMII/SRio——P}
Clock 3| cIK_SwW_PCle SWITCH
Generator
(CLK_GEN) 3 CLK_FPGA_PCle[1:2]
- 4 CLK_FPGA_Ref:
7 CLK_FPGA_SRio
8 CLK_FPGA Core FPGA
9 CLK FPGA 125M
10 CLK_FPGA_Ref3
CLK25M 5 4—|
VPX_RefClk——| VPX PO
> CPLD }—————————CLK_FPGA_12M5——

Figure 12: VF360 clock structure

The detail of the FPGA clocks and IO bank assignments are shown in Figure 13. Clock numbers are shown
inside the PLL blocks of the diagram.

21



PRODUCT OVERVIEW VF360 USER MANUAL

In the top side of the FPGA, the two QDR memories are placed in Bank 7 and the DDR memories in Bank 8. The
top side is fed by the following generated clocks: FPGA CLK_Core (100MHz), CLK_FPGA PCle2 (100MHz) and
CLK_FPGA _12M5.,

In the bottom side of the FPGA, Bank 3 and Bank 4 (A-C) connect to the LA[0:33] and HA[0:23] differential signal
pairs on the FMC connector, while the 24x single-ended VPX User I10s connect to Bank 4D.

The bottom side is fed by the following clocks: FPGA CLK_125M, CLK_FPGA_Ref (25MHz) and PO_AUX_CLK.
The FMC clocks CIk[0:1] M2C and CIk[2:3]_BIDIR also connect to the bottom side. CIk[0:1] M2C are parallel
terminated at the FPGA. CIk[2:3]_BIDIR connect to FPGA clock inputs and to closely located FPLL clock outputs.

On the left side of the FPGA, CLK_FPGA_PCle (100MHz) connect to transceiver (XCVR) reference clock input
REFCLK_LO and Clk_FPGA_SRIO (156.25MHz) connect to REFCLK_L5.

The 8x PCle lanes (connected to the PCle Switch), the 4x SRIO lanes (connected to the DSP) and FMC_DP[8:9]
(connected to the FMC site) connect to the transceiver interfaces on the left side of the FPGA.

On the right side of the FPGA, CLK_FPGA_Ref3 (125MHz) connect to transceiver (XCVR) reference clock input
REFCLK_RO and FMC clock outputs GBTClk1_M2C and GBTCIkO_M2C to FPGA inputs REFCLK_R2 and
REFCLK R4 respectively.

The 4x VPX HSSI lanes (X8d[1:4]), the 6x VPX HSSI lanes (X12d[1:6]) and FMC_DP[7:0] (connected to the FMC
site) connect to the transceiver interfaces on the right side of the FPGA.
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BANK 7A BANK 7B-7D BANK 8D-8B BANK 8A
1.5V 1.5V 1.5V 1.8V
RZQ 2x QDRII+x18 2x DDR3x32 DSP
Clk_FPGA_12M5
a5 Clk_Fpga_Core (100M)
Clk_Fpga_Pcie2:
first last Fpga_nReset
J
12,13, 14, 15 19’21)(81C]|5\1116 20, 21, 22,23
2X COR I 2X COR
2X LR Top ax 2X LR Top
RefCIkR G‘iLK RefClkL
FMC_DP[3:0] 5 5 [K—Clk_Fpga_SRio—

X12d[5:6] ——GBTCIkO_M2C— 4 4 Srio[0:3]
FMC_DP[7:4] 3 4X 4x 3 FMC_DP[8:9]
X12d[3:4] —GBTClk1_M2c— 2 GCLK GCLK 2 PCle[5:7]

X12d[1:2] 1 . _
X8d[1:4] —Clk_Fpga_Ref3— 0 | 0 Ky—Clk_Fpga_Pcie— PCle[0:4]
4X
GCLK
2X COR I 2X COR
8 2;( Lic? Ot11 ] 2XCEN 02)(1LR 2B Ota B
, 9, 10, 6,7 5 4 , 4, 2,
PLL_BR_LOOPT M N ' Kh——
_f\_/\_f\—pLL_BL_LOOP.f\_f\ /T M C|k3_B|D|R
G/\,\ AT AT /T /T ClkO Mzc_
g M 1) Clk1_M2c-
——Clk2_BIDIR Clk_Fpga_125M-
Clk_Fpga_Ref (25M)—
PO_AUX_Clk—
BANK 4A-4C BANK 4D BANK 3D-3A
Vadj (2.5V) 2.5V Vadj (2.5V)
LA[15:33], HA[19:23] VPX 24x SE LA[0:14], HA[0:18]

Figure 13: VF360 clocks and 10 banks
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2.8 Debug interfaces

The VF360 provides FPGA and DSP debug interfaces through the VR300 Rear Transition Module (RTM) and the
FM500 FPGA Mezzanine Card (FMC). Both the VR300 and FM500 provide:

% XDS100v1 via DSP mini USB connector
» Connectto TI TMS320C667X DSP
» In Circuit Emulation (ICE)
» USB Serial Port for debugging

» Compatible with Code Composer Studio

T =2

freeeeeeeeer

I

Figure 14: FM500 FPGA Mezzanine Card

«+ USB-Blaster Il via mini USB connector
» Connects to Stratix® V FPGA
» SignalTap® Il Logic Analyzer
» FPGA configuration and EPCQ Programming
% In addition to the above, the VR300
also provides a 1GBps Ethernet connection
from the DSP via a SFP cage.
« Jumper selection of DSP Boot option

« DSP reset push button

NOTE: Boot option and reset button only from issue-02 VR300 hardware

Figure 15: VR300 Rear Transition Module
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3 Specifications

This chapter provides the specifications for the functional
areas of the VF360.
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3.1 General Specifications

1. OpenVPX MOD3-PAY-3F2U-16.2.12-2 module profile
2. VITA 57 FMC site with LA and HA connections
3. VPX P2 connections according to ANSI/VITA46.9 Pin Field X24s+X8d+X12d
4, FPGA Transceiver maximum speed:
Transceiver Speed Grade 3... 8.5 Ghbps
Transceiver Speed Grade 2... 12.5 Ghps
5. DSP< FPGA SRIO speed... 3.125Gbps

3.2 Environmental Specification

3.2.1 Temperature

Operating (AC2, FC2)......... -40 to 50 degrees Celsius with a linear air flow of > 2.5 m/s
Operating (CC2)................ -40 to 55 degrees Celsius at the thermal interface (high-end design)
Operating (CC3)................ -40 to 70 degrees Celsius at the thermal interface (typical design)
Non-Operating (C3)............ -50 to + 100 degrees Celsius

3.2.2 Vibration
Operating (V1).....ccvvneeenene. TBC

3.2.3 Dimensions

Size (PCB) ..cceviiiiiiienene 160 mm x 100 mm (excluding connectors)
Size (PCB) ..ccvviiiiiienae 171 mm x 100 mm (including connectors)
Weight (AC).....cccvvvienienenne 450 ¢

3.3 Power Supply Requirements

The typical PSU currents required for the standard AC order code is shown in Table 2.

Table 2: VF360 Power supply requirements

. Nominal Minimum Current & Typical Current & High Current &

PSU Rail
Voltage Power Power Power

Vsl +12.0V 1A => 12W 15A =>18W 2A => 24W
Vs2 +3.3V 1.2A  =>4W 12A  =>4W 15A =>5W
Vs3 +5.0V 15A =>75W 24A  =>12W 4A => 20W
3.3V_AUX | +3.3v 03A =>1W 03A =>1W 03A =>1W
Total ~ 25W ~ 35W ~ 50W
Power
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3.4 Ordering Information

The VF360 ordering information is shown below
Generic order code = VF360-A-B-C-D-E-F-G

A: FPGA (A3, A4, A5, A7, A9, AB) for 5SGXAS3, 5SGXA4, 5SGXA5, 5SGXA7, 5SGXA9 and 5SGXAB
(D4, D5, D6, D8) for 5SGSD4, 5SGSD5, 5SGSD6 and 5SGSD8

B: Speed grade (2 or 3) for Transceiver speed, (C or I) for Commercial/Industrial temp & (1 to 4) for FPGA speed

C:DSP (1, 2, 4 or 8) for TMS320C667X one, two, four or eight DSP cores
D: DDR3 (2 or 4) GB total DDR3 memory (1GB|2GB for FPGA + 1GB|2GB for DSP)
E: QDRI+ (16 or 32) MB total QDRI+ memory (two banks of SMB|16MB for FPGA)

F: THERMAL (0 or 1) for air-cooled (AC) or conduction cooled (CC)

G: Conformal Coating (0 or 1) for un-coated or coated

Standard AC order code = VF360-A3-314-4-2-16-0-0
5SGXA3 FPGA 314 speed grade (Industrial temperature)
TMS320C6674 four core DSP @ 1GHz

DDR3 = 2GB, 1GB for FPGA (2x 512MB) + 1GB for DSP
QDRI+ = 16MB (2x 8MB) for FPGA

Air-cooled, un-coated

8-core DSP AC order code = VF360-A3-314-8-2-16-0-0
5SGXA3 FPGA 314 speed grade (Industrial temperature)
TMS320C6678 eight core DSP @ 1.25GHz

DDR3 = 2GB, 1GB for FPGA (2x 512MB) + 1GB for DSP
QDRI+ = 16MB (2x 8MB) for FPGA

Air-cooled, un-coated

Standard CC order code = VF360-A3-314-4-2-16-1-1
5SGXA3 FPGA 314 speed grade (Industrial temperature)
TMS320C6674 four core DSP @ 1GHz

DDR3 = 2GB, 1GB for FPGA (2x 512MB) + 1GB for DSP
QDRI+ = 16MB (2x 8MB) for FPGA

Conduction Cooled, coated

Contact factory for other order options
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4 Installation and Setup

This chapter includes instructions for unpacking and installing
the VF360.
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4.1 Unpacking the product

@)» Before unpacking the product, note the following guidelines:

Check the shipping carton for damage. If the product’s shipping carton is damaged upon arrival, request
that the carrier's agent be present during unpacking and inspection of the board.

Once unpacked, the board should be inspected carefully for physical damage, loose components etc. In
the event of the board arriving at the customer’s premises in an obviously damaged condition, Parsec or
its authorized agent should be notified immediately.

Make sure that the area designated for unpacking the product is a static electricity controlled
environment. Unpack the VF360 board only on a ground conductive pad using an anti-static wrist strap
grounded to the pad.

If moving the board is necessary, move it in an ESD protective container.
Note: The VF360 board is shipped in an ESD protective container.

4.2 Installing the VF360 Hardware

Once the VF360 has been unpacked and inspected, it can be installed in a 3U VPX slot that is compatible with
module profile MOD3-PAY-3F2U-16.2.12-1/2 and the following slot profiles:

V4
N

% SLT3-PAY-3F2U-14.2.13
% SLT3-PAY-2F2U-14.2.3

% SLT3-PAY-1F2U-14.2.12

Plugging the VF360 into any other slots is NOT supported and can seriously damage the VF360.
Parsec should be contacted on any questions regarding VF360 compatible VPX slots.

It is strongly advised that, when handling the VF360 and its associated components, the user should
wear an earth strap to prevent damage to the board as a result of electrostatic discharge.
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The board is installed and powered up as follows:

< Attach an antistatic wrist strap to your wrist. Attach the other end to ground.
« Power down the VPX rack.

+ Inspect the VF360 VPX connectors for any damage or debris.
» DO NOT insert the VF360 if any connector damage or debris is visible.

«» Carefully insert the VF360 into the VPX slot and secure by using the front panel handle.

« Secure the front panel with mounting screws at the top and the bottom.

< Apply power to the VPX rack and observe the LEDs through the small front panel holes

o The top LED should flash yellow, indicating the Linux heartbeat.

o The 3" LED from the top should flash green (@ 2Hz) indicating that the FPGA clock is running.

4.3 Installing the VF360 Software and Firmware
The CD shipped with the VF360 contains the following:

< Documentation
« Software (BSP)

o Linux kernel, Linux file system and IBL

o Linux PCle driver (PCI-04) and test application for FPGA PCle interface

o Linux PCle Endpoint drivers (EP) and Root Complex (RC) drivers for DSP

o Linux X86 drivers for DSP and FPGA.

o SYS/BIOS sample application for SRIO communication between DSP and FPGA

No files from the CD need to be transferred to the VF360.

The PCI-04 and SBC drivers need to be installed on an X86 based Single Board Computer (SBC) performing the
System Controller function, with a VF360 as a Slave module (non-System Controller) in the VPX rack. Refer to [1]
for more detail on the VF360 software BSP and Endpoint mode.

7

<  Firmware

The VF360 FPGA is configured with the Firmware Reference Design after power-up, no firmware need to be
installed onto the VF360. Refer to [2] for more detail on the VF360 Firmware Reference Design.
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4.3.1 Directory structure

The VF360 CD directory structure shown in Table 3.

Table 3: Install CD directory structure

Directory Description\ Contents

VF360 User Manual

VF360 Software Reference Manual
\Documents VF360 Firmware Reference Manual
FM500 FMC Product Brief

VR300 RTM Product Brief

\Software\binaries Linux kernel, Linux filesystem and IBL (Bootloader) binaries
\Software\kernel Linux kernel source code and build files

\Software\pcio4 Linux PCI04 driver and test application for FPGA PCle interface
\Software\pci_ep Root DIR for endpoint drivers

\Software\pci_ep\ep_drv Linux PCle driver for DSP EP (endpoint) on VF360 Slave module

Linux PCle driver and test application for DSP RC (Root complex)
on VF360 System Controller module

\Software\pci_ep\sbc_drv Linux PCle driver and test application for X86 SBC RC

SYS/BIOS sample application for SRIO communication between
DSP and FPGA

\Software\pci_ep\wf360_drv

\Software\sys_bios

\Firmware Root DIR for firmware files

4.4 Installing Code Composer

Code composer Version 5.3 needs to be installed as development/debug environment for VF360 software. This
also installs the drivers for the XDS100 emulator on the FM500 FMC and VR300 RTM.

4.5 Installing Quartus Il

Quartus 1l Version 14.0 or later needs to be installed as development/debug environment for VF360 firmware.
This also installs the drivers for the USB-Blaster Il on the FM500 FMC and VR300 RTM.

4.6 Installing a terminal program

A terminal program like Windows Hyper Terminal or PUTTY need to be installed, since the VF360 does not have
a GUL

PUTTY can be found at www.putty.org

The VF360 is now ready for use, refer to § 5 for more detaiil.
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5 Operating Guide

This chapter provides information on proper operation of the
VF360.
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5.1 Configuration Settings

VF360 USER MANUAL

All configuration settings on the VF360 are performed through the BIOS settings, refer to 8 6.1 for detail.

5.2 Status Indicators

The VF360 has six front panel LEDs mounted on the bottom side of the PCB, visible through small pinholes in the
front panel. The top two yellow LEDs are connected to the DSP and the bottom four LEDs to the FPGA. The LED

functions allocated to the DSP and the Firmware Reference Design is shown in Table 4.

O

parsec

Table 4: Front panel LED indicators

Position LED | Status Status description
15 LED yellow
(top) D18 | Flashing Linux heartbeat
nd
27 LED yellow D17 | Flashin Linux NAND flash
9 access (HDD)
3" LED green FPGA out of reset and
D16 | Flashingat2Hz | CLK_FPGA 125Mis
running
4™ LED green
D15 | Flashing at 0.5Hz | FPGA QDR initialized
5" LED green
D14 | Flashing at 0.5Hz | FPGA DDR initialized
th
?bo;'gg)gree” D13 | on FPGA SRIO initialised
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5.3 VF360 Software

This section describes aspects related to software development on the VF360. The VF360 boots Linux on DSP
core0 and runs SYS/ BIOS on the remaining cores. For detail on the BSP, refer to [1].

5.3.1 DSP PCle mode (Root Complex or Endpoint)

When the VF360 is booted in the System Controller (SYS_CON) slot of the VPX rack, the DSP is the Root
Complex of the PCle bus and enumerates all PCle endpoints.

When the VF360 is not in the System Controller (SYS_CON) slot of the VPX rack, the DSP can act as a PCle
Endpoint (‘Slave’) and be enumerated by the System Controller (typically a Single Board Computer). For the DSP
to function as a PCle Endpoint, the PCI Endpoint setting must be enabled in the VF360 BIOS, as the default is
Off.

It may be necessary to delay the PCle enumeration of the SBC until the VF360 DSP has booted. This can be
done in one of two ways:

1. Change the PCle reset delay in the BIOS of the SBC to > 15s.
2. Enable the open-collector SYSRESET output of the VF360 (as a Slave module) in the VF360 BIOS. This

causes the VF360 to keep the System Controller SBC in reset until the VF360 DSP has booted. The
DSP Endpoint will then be enumerated by the SBC. Refer to § 6.1 for detail on the VF360 BIOS options.

5.3.2 XDS$S100 serial port

Plug a USB cable into the mini USB connector labelled DSP on the FM500 or VR300. Refer to § 2.8 for detail.

To connect to the DSP serial port, set-up PUTTY (or other terminal emulator) to 115200 baud, 8N1 with no flow
control. When powering the VF360 while connected to PuTTY, the Linux booting information should be displayed
in the terminal window.

Type ifconfig; the VF360 IP address should be displayed if connected to a DHCP server.

Figure 16: ifconfig terminal window
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The VF360 default setup is for a dynamic IP address by a DHCP server. This can be changed to a static IP by
editing rc.sysinit in /etc. Remove comment (#) before the ifconfig command and comment out the udhcpc

y eth0 10.0

command.

Type Ispci; as a minimum the VF360 PLX PCle Switch and the ALTERA FPGA should be displayed.

Figure 17: Ispci terminal window

5.3.3 Ethernet connection

Connect an Ethernet cable into SFP transceiver module on the VR300, or into the Ethernet Switch card in the
VPX rack. Telnet to the VF360 on port 23 and login as root. The terminal should now show the Linux root
directory.

5.3.4 Monitor application and BIOS settings

The Linux host (running on DSP Core0) runs a VF360 Monitor application (vf360mon) that serves important
VF360 related information via Ethernet. The vf360mon help screen is shown in Figure 18.

For more detail on vf360mon, refer to § 6.1.

For more detail on the VF360 BIOS options, refer to § 6.2.

commands

Figure 18: VF360mon help screen
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5.3.5 FPGA Configuration

The FPGA can be configured from a Raw Binary File (RBF) by the DSP (under Linux) with the following
procedure:

“cd /fpga”

“./fpgaprog.sh <RBF file name>”"

5.3.6 Code Composer

Run Coder Composer (Version 5.3 or later). Create a new Target Configuration under
View => Target Configurations => Create New target Configuration File

Select the XDS100v1 connection and the TMS320C6674 device.

Connection Texas Instruments XD5100v1 USB Emulator -

Beard or Device type filter test

Th5320C6670 -
Th5320C6671
TM5320CE672
V| TM5320C6674
TM5320C6678

Figure 19: Code Composer target Configuration

Save the configuration and Test the connection, it should pass.

Go to View => Target Configurations and Launch the Selected Configuration (right click). It should now display
the four DSP cores. Right click on a Core (C66xx_0/1/2/3) and Connect.

%5 Debug 3 [

a s VF360.coxml [Code Composer Studio - Device Debugging]
4 @ Texas Instruments X05100v1 USE Emulator_0/ 0660 0 (Suspended)
= 0xB0002280 (no symbols are defined for 0x80002280)
X@ Texas Instrurments X05100v1 USE Emulator_0/ 0ol (Disconnected : Unknown)
X@ Texas Instrurnents XD5100v1 USE Emulator_0/Co0wo_2 (Disconnected : Unknown)
ﬁ Texas Instruments XD5100w1 USE Emulator_ 0/ Colo_3 (Disconnected @ Unknown)

Figure 20: Code Composer DSP Core0 connected

A compiled .out file can now be loaded onto a DSP core with the Run => Load Program command
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5.3.7 DSP Boot options
The VF360 provides a dual-boot option for the DSP from NAND flash.
This allows the VF360 to boot from other operating systems which are typically used for:

e Real-time control

e DSP processing

e  Safety critical applications
For solutions requiring other operating systems for deployment, the VF360 can be booted from the 2™ OS
partition (0S2), or OS1 can be overwritten with the required operating system. A recovery boot partition is
provided in-case the default boot partition is corrupted. The NAND flash has 8 partitions as is shown in Table 5
and contains Operating System (OS) and File System (FS) partitions.
With the default BIOS settings, the DSP boots Linux from OS1 and uses the file system in FS1.

Table 5: NAND flash partitions

Partition (S,\}ée) Name Description Default contents

0 0.25 Reserved N/A Empty

1 15.75 0Os1 gesfault boot Linux kernel

2 240 FS1 Default FS Linux file system

3 16 0S2 2 boot OS | Empty

4 256 Fs2 2YFs Empty

5 432 FS3 3“Fs Empty

6 8 Recovery OS Recovery OS | Linux kernel

7 56 Recovery FS Recovery FS | Linux file system

The boot selection can be made through the Boot BIOS setting, or through the GDiscretel OpenVPX backplane
signal, refer to § 6.2 for detail.

When the GDiscretel BIOS Boot option is selected, the level of GDiscretel at boot time determines which OS is
booted from. When a VR300 Test RTM is present in a system, GDiscretel can be controlled by the J2 jumper on
the VR300, refer to Table 6.

Table 6: GDiscretel Boot selection

. Boot Boot . .
GDiscretel level oS FS VR300 J2 jumper position
Low 0Os1 FS1 Position 2-3
High 0Ss2 FS2 Position 1-2 (or open)

An example SYS/BIOS application binary that can be booted from is provided on the default Linux file system,
refer to for [1] detail.
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5.3.8 SYS/BIOS development

On the VF360 CD, as part of the BSP, there is a Code Composer project that runs under SYS/BIOS. This
example application shows how the FPGA is accessed by the DSP via the SRIO interface.

5.3.9 Linux development

Information on the TI DSP Linux kernel and development compilers, refer to http://linux-c6x.org

5.4 VF360 Firmware

A block diagram of the VF360 Firmware Reference Design is shown in Figure 21 and contains the following main
blocks; VF360_dsp_if, VF360_mem_if, HSSI and User_logic.

The vf360_dsp_if block provides the PCle and SRIO external interfaces, as well as Avalon Streaming (AST) and
Avalon Memory Mapped (AMM) internal interfaces to vf360_mem_if and user_logic.

The vf360_mem_if block provides the external interfaces for the two DDR3 and two QDRI+ memory banks, as
well as the AMM internal interfaces to access them via PCle or SRIO.

The hssi block provides transceiver interfaces for the 18 HSSI links on the right bank of the FPGA. These
transceivers can be setup and controlled (by the DSP) via the HSSI AMM control bus.

The user_logic block is a template for users to implement their own firmware.

Vf360_fpga_top

PCle HSSI Aval . HSSI
< > User Avalon ¢ VElem hssi ¢ )
Memory Map Memory Map
—>

<« RO, vi360_dsp_if user_logic

DDR3_1
<“—>
DDR3_2
vf360_mem_if
QDR_1

QDR_2

QDR (Mem0) Avalon Memory Map

DDR (Mem1) Avalon Memory Map
SRIO Passthrough AST (Optional)

Figure 21: VF360 Firmware Reference Design top level diagram

For more detail on the VF360 firmware, refer to the VF360 Firmware Reference Manual [2].

5.4.1 FPGA BAR Requirements
Table 7 gives an overview of the VF360 FPGA PCle BAR requirement. For more detail refer to [2].

Table 7: Overview of FPGA PCle BAR requirement
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Memory space Size
requested

PCle BARO 16MB

PCle BAR1 256KB

PCle BAR2 32KB

5.4.2 ALTERA USB-Blaster Il
Plug a USB cable into the mini USB connector labelled FPGA on the FM500 or VR300. Refer to § 2.8 for detail.

NOTE: On the VR300 the FPGA mini USB connector is close to the VPX backplane connectors and is accessed
through the slot in the PCB.

When prompted for the USB-Blaster driver, browse to the “\\altera\quartus\drivers” directory for completion of the
installation.

Run the Quartus Il Programmer, click on “Hardware Setup” and select the available USB-Blaster.

" Quartus I 64-Bit Programmer - [Chainl.cdf] *— (= [ 2 o

Fle Edit View Processing Tools Window Help 5 Search altera.com @
£, Hardware Setup...| No Hardware Mode: [JTAG '] Progress: l J

[ Enable real-time 15F to allow background programming (for MAX IT and MAX V devices)

Figure 22: ALTERA USB-Blaster setup

5.4.3 Configuring the FPGA

To configure the FPGA (volatile), click on “Auto Detect” and select the relevant FPGA device, i.e. 5SGXMA3K3
for the standard VF360. The FPGA is now listed. Right click on the FPGA in the list, select “Change File” and
browse to the .SOF file to configure the FPGA with. Tick the “Program/Configure” box and press “Start’. The
VF360 FPGA will now be configured with the selected .SOF file.

The FPGA configuration is volatile and will be lost after a power cycle.

File Device Checksum Usercode Program/ Werify Blank- Examine Security Erase ISP
Configure Check Bit CLAMP

C:pds/Projects/Parsec/Vpx/VF360/FV /VF 360_FPGA/qis/v... SSGXMAZKIF40 0AD3BIFD DAD3B1F0 ] ¥ ] [F] [] ||

bl Start
a0 Stop

$a Auto Detect

3 Delete
[ Add File...

% Change File i: H

Al Save File

[*# Add Device...

foup

4 Down

Figure 23: FPGA configuration via JTAG
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5.4.4 Programming the FPGA configuration device

To program the FPGA configuration device (EPCQ), a .JIC file first need to be created from the .SOF file.
In Quartus Il or the Quartus Il Programming, go “File => Convert Programming Files”

Set Programming File Typeto =>.JIC

Set Configuration Device to => EPCQ256

Set Mode to => Active Serial x4

Select Flash Loader and click on Add Device, select the Stratix V Device family and the 5SGXMA3K3 Device
name (standard VF360).

Select SOF Data and then Add File to add the SOF file created in Quartus, refer to [2] for detail.
Select the added SOF file, click on Properties and tick (enable) the Compression box, then press OK
Click Generate to create the .JIC file

Add the generated JIC file to the Quartus Il Programmer and program the FPGA.

Power cycle the VF360 and the FPGA will be configured with the programmed SOF data.

File  Tools  Window Search altera.com @
Conversion setup files i
Open Conversion Setup Data... ] [ Save Conversion Setup... ]
QOutput programming file
Programming file type: | ITAG Indirect Configuration File (.jic) - ]
Options. .. Configuration device: [EPCQ?_EG * | Mode: Active Serial x4 - ]
Filz name: output.jic E]
RemotefLocal update difference file: NOME
Create Memory Map File (Generate output.map)
Create CwP files (Generate output.periph.jic and output.core.rbf)
[ create config data RPD (Generate output_auto.rpd)
Input files to convert -
File/Data area Properties Start Address Add Hex Data
4 Flash Loader
SSGXMAZKE Add Sof Page
4 SOF Data Page_0 <auto> Add File. ..
vf360_fpga_top.sof 5SGXMASKIF40
Up
Down
Properties
Generate ] [ Close ] [ Help ] e

Figure 24: FPGA programming via JTAG
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6 Monitor, BIOS & GPIOs

This chapter describes the VF360 BIOS settings and the DSP
GPIO usage.

a1
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6.1 Monitor commands

Vf360mon is accessed via telnet port 4360, i.e. telnet <IP> 4360. When using the XDS100 serial port on the
FM500 FMC or VR300 RTM, vf360mon is access by telnet 127.0.0.1 4360.

The vf360mon commands are listed in Table 8

Table 8: VF360mon commands

Command Description
help List the vf360mon commands
ping Check if host replies with a pong
rtc Get or Set the real-time clock on the VF360
time Shows the time of the Linux OS
Shows status of PSU rails, device temperatures and
status
clock generator
hwinfo Shows hardware status (i.e. Serial number, PCB,
Mechanics, DSP, FPGA and memories)
osinfo Shows Linux uptime, RAM usage and loading
version Shows the versions of vi360mon, MANCON SW
and FPGA FW
bit Check vf360mon communication between DSP and
MANCON
bios Shows the safe default and user BIOS settings
log Shows boot or PSU failures
Performs a warm or cold reset of the VF360.
reset A warm reset, resets the DSP
A cold reset re-powers the VF360
reboot Same a warm reset
restart Same as cold reset
Unlocks the protected command, i.e. BIOS reset and
pass
update

6.2 BIOS settings

The VF360 provide a set of user BIOS settings and a safe default set. The BIOS is accessed through the
vi360mon service that is accessed via telnet <IP> port 4360. The user settings can be reset back to the safe
defaults by entering reset user in the BIOS menu.

To access the BIOS settings a password is required; type “pass vf360”.

A BIOS command is executed by typing “bios command parameters”

The BIOS commands provided are listed in Table 9.

The VF360 can be forced to boot with the following safe default BIOS values:
Ethernet_auto_neg, LinuxMem and PCle_EP.

This is done by pressing “s” on DSP serial port terminal while re-booting Linux.

42



BIOS & GPIOS VF360 USER MANUAL

Table 9: BIOS Commands

Command Parameter(s) Description
bios List the safe default and user BIOS Register values
Resets the user BIOS settings back to the safe settings
reset user / safe Resets the safe BIOS settings back to hardcoded safe
settings
. Updates a BIOS register with value specified in Vall.
u Register Vall [ValZ] Some registers requires 2 parameters, Vall and Val2
help Register Provides help on a specific BIOS register

Table 10 gives an overview of the VF360 BIOS settings. For the most current BIOS settings and options, run the
bios command in vf360mon. Run help <entry> for detail on a specific entry.

Table 10: BIOS Register Settings

BIOS Register
Entry

Default

Description

System_Controller

Backplane

Sets VF360 System_Controller mode to On, Off or
Backplane determined.

SYSRESET

System_Controller

Sets SYSRESET output as On or System Controller

SYSRESET _Delay

0

Additional SYSReset delay in 250ms increments

PCIeRESET_Delay

0

Additional PCle Reset delay in 250ms increments

MaskableReset_Input

Off

Enable Maskable Reset for DSP warm reset (from
RTM or FMC)

NVMRO

Off, non-active

Non-Volatile Memory Read Only enable and activate

System_Management | Off Enable System Management bus SM[3:0]
Ethernet auto ne ETHO=0n Set DSP Ethernet auto negotiate mode on ETH1
—AUo_Neg | Erpyg = of (CPutp02) and ETHO (Cputp01).
Fixed_Vadj 2.5V (BIOS) Set Vadj voltage from BIOS or FMC
- - S
LinuxMem 896 MB Memory allocated to Linux running on 1~ core
(Core0)
PCle BKP On, On, On Enable/Disable Backplane PCle ports DP01, DP02
- & DP03
PCle EP Off, 32MB Activate Slave_ mode DSP PCle endpoint (EP) and
- set EP BAR size
Selects the Boot Operating System (OS) and File
Boot Boots OS1 & FS1 System (FS). Refer to § 5.3.7.
CLK_DSP_Core Reserved
CLK_DSP_DDR Reserved
CLK_PCle Reserved
Reserved

CLK_FPGA_Ref

REF_CLK

System_Controller

VPX PO RefClk output set as Off or

@ 25 MHz System_Controller @ frequency
CLK_DSP_SRIO Reserved
CLK_FPGA_SRIO Reserved
CLK_FPGA_Core Reserved
CLK_FPGA_125M Reserved
CLK_FPGA_Ref3 125MHz Frequency of CLK_FPGA_Ref3
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BIOS Register
Entry

Default

Description

DSP_ClockSpeed

Auto

Selects the clock speed of the DSP cores.
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6.3 GPIOs

The DSP GPIOs are used to determine the DSP boot mode during start-up. After DSP booting some of the
GPIOs are available to the user for specific (fixed) or general purpose (user defined) functions, e.g.
communication between the DSP and the FPGA. Some GPIOs are reserved for board management functions.
Table 11 lists the DSP GPIOs and indicates which are available to the user.

Table 11: DSP GPIOs

GPIO Coirfgc'?ion Function
0 Yes Fixed: FPGA Reset (active low)
1 Yes User defined
2 Yes User defined
3 Yes User defined
4 Yes Fixed: P1_Gdiscrete input from P1
5 Yes Fixed: P1_Gdiscrete output to P1
6 Yes Reserved: FPGA nStatus input to DSP
7 Yes Reserved: FPGA_ConfDone to DSP
8 Yes Reserved: 1PPS RTC_MFP (IRQ) to DSP
9 Yes Reserved: TBD
10 Yes Reserved: Linux Heartbeat LED
11 Yes User Defined
12 Yes User Defined
13 Yes Reserved: Linux NAND activity LED
14 No Reserved: FPGA nConfig
15 No Reserved: FPGA Configuration Enable
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7 Acronym List

AC

BAR

BSP

CcC

DMA

DSP

EP

ESD

EW

FMC

FPGA

FS

HSSI

JTAG

KB

MB

Mb

MT/s

MSPS

(ON)

PCB

PCI

PCle

PLL

Air cooled

Base Address Register
Board Support Package
Conduction Cooled
Direct Memory Access
Digital Signal Processor
Endpoint

Electrostatic Discharge
Electronic Warfare
FPGA Mezzanine Card
Field Programmable Gate Array

File System

High-Speed Serial Interface (FPGA transceivers)

Joint Test Action Group

Kilo Byte(s)

Mega Byte(s)

Mega Bit(s)

Mega Transfers per second

Mega Samples Per Second
Operating System

Printed Circuit Board

Peripheral Component Interconnect
PCI Express

Phase Locked Loop
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PSU

RBF

RC

RTM

SEEP

SDR

SFP

SIGINT

SRIO

Power supply

Raw Binary File

Root complex

Rear Transition Module
Serial EEPROM

Software Defined Radio
Small form-factor pluggable
Signals Intelligence

Serial Rapid 10
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